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Jensor 
 

Jensor is free software. You can redistribute it and/or modify it under the terms of the GNU 
General Public License version 2 as published by the Free Software Foundation. 

 
This program is distributed in the hope that it will be useful, but WITHOUT ANY 

WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS 
FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details. 

 
Copyright 2008, TATA Consultancy Services (TCS)
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About this Manual 

 

Purpose 

This manual has been written to help you understand and use the Jensor application. It presents the 
functional capabilities and operational details of Jensor, and contains the procedures that you should 
know for performing your business tasks using Jensor. Additionally, this manual provides information 
on the system requirements and installation of Jensor.  

 

Intended Audience 

This manual is intended for Java Developers, Testers, Production Support personnel and Project 
Managers who manage Java-based projects or products. 

Pre-requisites 

Following are the pre-requisites for performing the tasks presented in this manual: 

Functional The reader is expected to know how Java 
language executes a program. The reader should 
be familiar with analysis techniques that helps 
one detect and eliminate bottlenecks in a 
program. Programming skills in Java is an added 
advantage. 

Technical The reader is expected to know the following 

1. Syntax to execute Java programs 

2. Knowledge on how to set up / deploy the 
target environment in which the Java 
application will be executed. 

3. Good analytical skills. 

 

Organisation of the Manual 

Information in this manual has been organised as follows: 

Table 1: Organisation of the Document 

Chapter Description 

Chapter 1 Provides a brief introduction and conceptual model of Jensor. It also details the 
hardware and software requirements, and interfaces with other systems. 

Chapter 2 Takes you on a quick tour of Jensor. It gives a brief introduction about the 
general working features of Jensor that you should keep in mind while working. 
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Chapter Description 

Chapter 3 This chapter covers details about Jensor administration. The administrative tasks 
are pre-requisites before a remote JVM can be monitored. 

Chapter 4 Introduction to a Jensor Project 

Chapter 5 Jensor usage methodology is a simple 3 step process viz. Instrument – Deploy –
Profile. This chapter covers it in detail. 

Chapter 6 This chapter describes Jensor Control Engine. Jensor Control Engine helps 
control behavior of Jensor at run-time. 

Chapter 7 This chapter describes Jensor Analysis Workbench. 

Chapter 8 This chapter explains Jensor reports in detail. 

Appendix Covers Jensor Calibration Results, Resources and Roadmap 

 

Typographical Conventions 

The following table gives the details of the typographical conventions used in the document: 

Table 2: Typographical Conventions 

Formatting 
Convention 

Type of Information 

Key Names Keys on the keyboard appear in title case (first letter in upper case). 
For example, Page Up, Caps Lock. 

A combination of keys is connected by a +. For example, Shift + Tab 
means you should press the Shift key and Tab key together. 

Filenames Names of files and directories are in italics. Example, System.mdb. 

Command  and Screen  
element names 

Buttons, check boxes, etc. Commands that you choose from the 
menus or dialog boxes appear in title case and are bold-faced.  

Example: Click Instrument from the Mode menu. 

User-entered text Text that you would need to enter appears in Verdana� font 

 

Feedback and Suggestions 

Send in your feedback and suggestions to amol.khanapurkar@tcs.com 
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1 What is new in Jensor v1.10? 

 

In Jensor v1.9, the System Monitoring feature was added but it was available only for the 
Windows Platform, Jensor v1.10 provides the System Monitoring feature for the Unix Platforms. 

Jensor in v1.10 provides for System Monitoring for the Unix platforms as well. Jensor now 
collects the details regarding the Processor, Memory, Disk and Network or System Call Details 
on the Application Server. So the user now gets to see the details of System Utilization along 
with the Application details which will be an added advantage helping identify the effects the User 
load on the Application on the System as a whole. The metrics and the details related to System 
Monitoring are covered in detail under the section 9.10 System Metrics. 
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2 Introduction 

This section provides an overview of the chapter. 

2.1 Introduction to Jensor 

Jensor is a light-weight and a low-overhead Java Profiler. Jensor is designed to be fit for use under 
Production workloads. Jensor uses byte code instrumentation to obtain method response times and 
memory consumption details. Jensor 1.10 provides eight (8) different analysis tools to detect 
bottlenecks in the code. 

Jensor provides many useful features which are useful to a developer during Development cycle. 
Jensor has very negligible overheads which makes it useful in Test and Production environments. 
Thus Jensor provides a common mechanism for a developer, a tester and a production support 
personnel to troubleshoot performance defects. Jensor also has the unique ability of providing 
business perspective using technical data. This feature is very useful to project managers. 

 

2.2 Features of Jensor 

The following are some important features of Jensor: 

·  Has extremely low overheads (10 to 30 microseconds per method) and low memory footprint 
(typically less than 1 MB). 

·  Can carry out Adaptive Profiling. It can track its own overheads. 

·  Can provide method response time for all pure Java methods. 

·  Provides Heap Utilization statistics and Object allocation details, which can be used to 
ascertain if there are memory leaks in the application. 

·  Provide nine different analysis tools to detect bottlenecks 

·  Can provide a business as well as technical view based on the same underlying data 

·  Can do remote JVM monitoring 

·  Capable of Method-level Filtering while monitoring 
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2.3 Jensor Architecture 

This section describes Jensor architecture 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1. Jensor Architecture 
 

Jensor consists of 3 logical components 
1) Instrumentation Engine – This is invoked statically and consists of Byte Code Reader, 

Transformer and Writer 
 

2) Jensor Core1 – Jensor Core comes into play when instrumented code is executed. The Core 
consists of 3 components 

a. Log Writer for generating logs to be analyzed offline. 
b. Real-Time Statistics Engine for monitoring memory consumption and identifying 

bottleneck methods at run-time 
c. Control Engine – This controls Jensor behaviour at runtime. 
d. TCP / IP Server – Accepts signals to start / stop and collate Jensor data from local or 

remote JAW. 
 

3) Jensor Analysis Workbench (JAW)2 – This is invoked offline after Jensor output is obtained. It 
consists currently of 9 features viz. 

a. Summary Report – This component crunches Jensor logs and generates Summary 
Report which gives per thread per method statistics 

b. Call Trace – Creates entire call execution sequence with break up of response time at 
each level. 

c. JVM Replay – Allows replay of method executions happening in JVM. This feature 
can be useful in debugging reliability and scalability problems. 

d. Pattern Analysis Engine – This identifies patterns of interest from application 
performance perspective. This component contains 2 patterns viz. Elementary and 

                                                      
1 Jensor Core was called Profiling Engine in Jensor version 1.1 
2 Jensor Analysis Workbench (JAW) was called Analysis Engine in Jensor version 1.1 

Instrumentation Engine Jensor Core 
 
 
 

Jensor Analysis 
Workbench (JAW) 

Byte Code Reader 

Byte Code 
Transformer 

Byte Code Writer 
Log Writer 

Real-Time Statistics 
Engine  

Control Engine 

1. Reports 
2. Call Trace 
3. JVM Replay 
4. Pattern Analysis 
5. Charting Engine 
6. Un-exited  Methods 
7. Tagging 
8. Response-Time 

Spectrum 
9. Object Instantiations 
10. System Metrics 

TCP / IP Server  
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Advance pattern analysis. Only Elementary pattern Analysis is shipped with this 
version of Jensor. Advance Pattern Analysis will be distributed in later releases. 

e. Charting Engine – It currently provides graphical visualization for correlating method 
response time histograms and memory utilization. 

f. Un-exited Methods – This module provides useful pointers into debugging reliability of 
the application. Two modules provide information about un-exited methods. 

g. Tagging – Three modules in Jensor are dedicated to tagging. Tagging is the process 
in which one declares ‘Tags’. Next tags are applied to technical data obtained from 
Jensor. Jensor then provides break-up and visualization based on Tags. Further 
more, Tags can be nested to bring out appropriate correlation between different 
categories of tags. Using tags it is possible to create a business perspective of 
technical data. 

h. Response Time Spectrum – Averages typically dilute information about response 
time. This module depicts response time of all occurrences of selected methods 
against wall clock time. This module enables identifying periods of the day where a 
method performance degraded and by how much. 

i. Object Instantiations – Shows memory graph and details about object allocations 
grouped by methods. This module allows one to select time range and get 
information about allocated object type and allocating method along with count of 
number of objects allocated. A high allocation of a particular object type within a  
method can provide useful pointers to memory consumption by that method. 

j. System Metrics - Shows data related to System Utilization. This module helps the 
user to identify any significant changes in certain System Utilization metrics. 

 

 

2.4 Jensor Conceptual Model 

This section describes the conceptual model behind Jensor 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2. Jensor Conceptual Model 

 

Conceptual model of Jensor comprises primarily of 4 components viz. 

1) Jensor Core, referred to as Jensor in rest of the document. The Core consists of 



Jensor 1.10 Usage Manual 

      5
  

a. Filters – Not discussed in this document (FT) 

b. Aggregators – Not discussed in this document (AG) 

c. Control Engine – Described in chapter 6 

d. TCP / IP Server -  Described in chapter 3 

2) Jensor Communication Engine (JCE) 

3) Persistent Data Store (PDS) 

4) Jensor Analysis Workbench (JAW) 

 

For Jensor to be able to capture data from a Java application, the application needs to be Jensor-
enabled. One needs to perform instrumentation to Jensor-enable an application. Instrumentation can 
be performed on command line as well as using JAW UI. Once the instrumented code is deployed 
back in the target environment Jensor Core captures response times and memory utilization data. 
This data is stored in Persistent Data Store which currently, in this release of Jensor is a file on the file 
system. This data needs to be crunched using Jensor Analysis Workbench (JAW) . The JAW can 
either be on the same system as Jensor or it can reside on a remote machine. The JAW can be used 
to send signals to Jensor to start / stop and collate data. If the JAW resides on a remote machine, the 
remote machine IP address as well as the current logged in user need to be authorized to be allowed 
to access Jensor data. If the JAW resides on the same machine, access to Jensor data is granted by 
default. Upon successful System as well as User authorization Jensor data is transferred over TCP / 
IP to remote JAW. This is called Collation of Records in Jensor terminology. Collating records causes 
Jensor to stop collecting data. Explicit start session command needs to be issued through JAW to 
restart the data collection. All the communication between Jensor Core and JAW happens through 
JCE which uses TCP / IP protocol for transmitting signals and data. 

 

2.5 Jensor Environment 

This section describes the hardware and software environment required to run Jensor. 

2.5.1 Software Environment 

Operating System ��������	
����
��
���������
������������	���	�����

JDK / JRE version �	�	�����	���	�����

Table 2 Software Environment 

 

2.5.2 Hardware Environment 

Machine Architecture �����	���	���
����������
������������	���	�����

RAM ����� �!�����"���������

CPU Speed #�
�$%�����&��'�()*��

��%�# ��&���+'��)*��

Disk Space ����������( �,�������-�
�	"��
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Table 3. Hardware Environment 

 

2.6 Additional Configuration Settings 

Jensor installer for Windows creates environment variable called JENSOR_HOME. If admin rights are 
not available, environment variable will need to be created manually. To create environment variable 
on Windows go to Control Panel  -> System  -> Advanced  -> Environment Variables . 
JENSOR_HOME will need to be assigned value of the directory where Jensor was installed, typically 
C:\Program Files\Jensor. 

 

On Unix, add JENSOR_HOME environment variable to your profile file. JENSOR_HOME should be 
assigned the value where Jensor was extracted to. For example, if you untar-ed Jensor into 
/home/perf then JENSOR_HOME should be assigned the value /home/perf/Jensor. Consult your 
system administrator for syntax for setting environment variables for your flavor of Unix operating 
system. 
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3 Getting Started 

This section provides chapter overview. 

3.1 Starting and Quitting Jensor 

To launch Jensor execute the startup script loacated in %JENSOR_HOME%/bin. On Windows the file 
name is startup.bat and on Unix the file name is startup.sh. On Unix check that execute permissions 
are granted for startup.sh. Upon Jensor launch, the following Java Swing based UI is launched. 

 

 

 

 

 

 
Fig. 3. Jensor Login 

Use Administrator as username and perf123 as password to log in to Jensor. Upon successful log in 
you will see the following screen. Click on Help -> Version to verify that current version is Jensor 1.10. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Fig. 4. Jensor UI 
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3.2 Working with the Jensor Interface 

Jensor UI is a simple UI developed in Java Swing. It consists of a Menu bar and a Status Bar. The UI 
consists of 3 menus viz. File , Mode and Help . The Status bar provides information about Jensor’s 
memory consumption and current project in use. 

3.2.1 Using Menus and Toolbars 

This section provides details about using the menus 

You can use menu to access Jensor functionality to perform BCI, analyse output and do 
administrative tasks.  

The File menu consists of 5 menu items viz. 

·  New :- Creates a new Jensor Project 

·  Open :- Opens an existing Jensor Project 

·  Delete Project :- Deletes the Project from local file system 

·  Delete Session :- Deletes the selected Session from the currently open project 

·  Close  :- Closes an existing Jensor Project 

·  Exit  :- Exits Jensor UI 

 

The Administration menu is only available to the administrator. Default password of this user is 
perf123. This menu consists of 3 menu items viz. 

·  Change Password :- Changes password of existing user(s) 

·  System Admin  :- Allows administrator to add a list of systems which can remotely 
access Jensor data on this machine. 

·  User Admin :- Allows administrator to add / remove and grant access to users. 
Different kinds of access rights in Jensor include  

o Start Session – Send signal to Jensor using local / remote JAW to start 
capturing data 

o Stop Session - Send signal to Jensor using local / remote JAW to stop 
capturing data 

o Collate Records – Send signal to Jensor to stop capturing data and transfer 
already collected data to local / remote JAW 

o Perform GC –  Send a signal to Jensor to call the Garbage Collector 

 

The Mode menu consists of 8 menu items viz. 
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·  Instrument  :- Opens Jensor UI for performing instrumentation 

·  Start Session :- Asks information regarding host and port where Jensor is running 
and then sends signal to that JVM to start collecting data. Valid authentication 
credentials on remote JVM are required for this to work. 

·  Stop Session :- Asks information regarding host and port where Jensor is running 
and then sends signal to that JVM to stop collecting data. Valid authentication 
credentials on remote JVM are required for this to work. 

·  Collate Records :- Asks information regarding host and port where Jensor is running 
and then sends signal to that JVM to stop collecting data and then transfer already 
collected data to JAW. Valid authentication credentials on remote JVM are required 
for this to work. 

·  Offline Collation :- Asks for the zip file containing the Jensor logs. This feature is 
useful where the files may exist on a remote server but it may be a challenge to 
transfer the logs (for example huge size file transfer on a low bandwidth etc) on to the 
JAW machine. In such cases , the user can use the Offline collation feature. The 
steps to be followed are as follows 

o Zip the contents of the %JENSOR_HOME%\output directory, namely 
JensorProfile.txt, memusage.csv, topNMethods.csv, ObjectInst.txt and 
SystemUtilization.txt files. Not all files are necessary. This module can create 
appropriate analysis reports based on what files are contained in the zip. The 
mapping of files to analysis modules is as follows 

�  Memusage.csv – Charts -> Memory Utilization 

�  topNMethods.csv – Charts -> Method Histogram 

�  ObjectInst.txt -> Object Instantiations 

�  SystemUtilization.txt -> System Metrics 

�  JensorProfile.txt -> Everything else 

So if any of the files is missing, corresponding analysis module wont get data. 

o Copy the zip file from the remote machine onto the local machine 

o Direct the JAW to the zip file on the local machine. 

o If the Project for which the logs were collected does not exist on the JAW, a 
new Project will be created. Else the logs will form a new session under the 
existing project. 

·  Perform GC :- Asks information regarding host and port where Jensor is running and 
then sens signal to that JVM to perform the Garbage Collection. On return it displays 
the amount of Free memory before GC as well as that after GC. 

·  Analyze  :- Jensor provides 8 different analysis tools for analyzing output. Analysis 
tools are available as sub-menu items. 

o Summary Report  :- Provides summary report of Jensor output 
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o Debug Tree  :- Provides method call trace based on Jensor output 

o JVM Replay  :- Provides replay method call sequence in the JVM. The call 
sequance can be animated to debug performance, scalability and reliability 
problems. 

o Pattern Analysis  :- Captures patterns in Jensor output 

o Charts :- Provides method response time histogram and memory utilization 
charts. The histogram and memory utilization charts can be animated to 
obtain correlation between method response times and memory utilization. 

o Response-time Spectrum  :- Provides method response time details in form 
of a spectrum. Zoom-in and zoom-out features aid in detailed analysis of 
method response times. 

o Unexited :- Provides information about methods that do not / abnormally exit. 

o Rebuild :- Rebuilds all analysis reports from original files belonging to a 
given session. 

o Tagging  :- This sub-menu is used for using Tagging functionality. This is 
explained in detail in 8.7 

o Object Instantiations :- Provides details regarding the objects that were 
instantiated during the time period selected. This is explained in 8.9 

·  Change Properties  :- Provides screen to change Jensor UI configurations. Most 
notably, you can alter the depth of call trace and pattern analysis by changing 
configurations here. 

 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 

Fig. 5. Jensor UI Menus 

 

The Help menu consists of 3 menu items viz. 
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·  About Us  :- Self-explanatory 

·  Terms and Conditions  :- Contains acknowledgements and credits to authors of 
other software used in Jensor.  

·  Version :- Version and build date of installed copy of Jensor. 

 

3.2.2 Using Shortcut Keys 

The shortcut keys for invoking menu as well as sub-menu is marked with respective mnemonics. The 
following examples demonstrate use of shortcut keys. 

 

For Mode Menu – Alt + M 

For Mode - Analyze – Alt + M + A 

For Mode – Analyze - Summary Report – Alt + M + A +S 
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3.3 Usage Methodology 

This section describes Jensor’s usage methodology, covering the 3-step process of Instrument, 
Deploy and Profile. 

 

3.3.1 Instrument 

Jensor works on Byte Code Instrumentation (BCI) technique. For Jensor to be able to capture data 
Java classes need to be instrumented. This version of Jensor requires manual instrumentation. Future 
versions of Jensor will support automatic instrumentation. Instrumentation is supported through 
Instrument  menu item in Jensor UI. 

Jensor works on the concept of a “Project”. To instrument Java classes, one creates a Jensor Project 
through UI. Next, Jensor will need to be navigated to location of class or jar or war or ear files which 
need to be instrumented. Before Instrumenting, Jensor will backup a copy of original uninstrumented 
code. It will then instrument the code and keep the instrumented code in “instrumented” directory 
under the project. 

 

3.3.2 Deploy 

One will then need to pick up the Instrumented code from “instrumented” directory of the 
corresponding Jensor Project. This instrumented code will then be required to be deployed in the 
target environment using ones own deployment methodology. Also Jensor Jar jensorjdk14-<version>-
<platform>, contained in JENSOR_HOME/lib directory will need to be in application classpath. 

Note:- It is necessary to ensure that the deploymen t process does not compile application 
code. Compiling will remove Jensor instrumentation.  This typically happens when using IDEs 
like Eclipse etc., to deploy application code. 

 

3.3.3 Profile 

Once deployment is successful, profiling data will automatically be collected in files in 
JENSOR_HOME/output directory. After Collate Records, the data is automatically shipped to 
appropriate project folder. 
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4 Jensor Administration 

4.1 Introduction to Jensor Administration 

This section provides an overview of administrative tasks that can be performed in Jensor. 

 

The Administration module deals with creating secure environment between JAW and Jensor. It is a 
rudimentary attempt to provide security to captured profiling data. The security principles are as 
follows 

1) Who is allowed to access profiling data? and 

2) From what systems? 

Consider the following scenario to understand the security mechanism in Jensor. Say, machine A is 
the server which runs application X and say machine B is the developer workstation. The developer 
wants to profile application X running on server A. S /he instruments the code and deploys it on 
machine A. Now, if the developer wants to access the profiling data sitting on his/ her machine B the 
following steps need to be followed. 

1) Create System account in machine A for machine B 

a. Launch JAW on server A 

b. Go to Administration -> System Admin 

c. Enter IP address or hostname of machine B 

2) Create User account in machine A 

a. Launch JAW on server A 

b. Go to Administration -> User Admin -> Add User 

c. Create a user and share the username / password with the developer 

3) Create same User account in machine B i.e the developer machine 

a. Launch JAW on server A 

b. Go to Administration -> User Admin -> Add User 

c. Create a user and share the username / password with the developer 

 

Developer will now be able to start / stop and collate data from remote Jensor running in JVM of 
application X deployed on machine A. There are certain “project” logistics that one needs to handle. 
These will be explained in section 5.1 
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4.2 Assigning User Access Privileges 

There are 3 different privileges that a user has viz.  

�  Start session 

�  Stop Session 

�  Collate Records 

 

A user with Start Session privilege can send signal to local or remote Jensor to start capturing data. 
Similarly a user with Stop Session privilege can send signal to local or remote Jensor to stop 
capturing data. Collate Records privilege implies Stop Session privileges since Jensor first stops data 
collection and then collates and sends data to local or remote JAW. In case of remote JAW files are 
transferred over TCP / IP. Hence any TCP / IP level tuning at OS layer can be performed to speedup 
file transfers.  

 

The User Interfaces to add / remover users and change password / grant privileges are self-
explanatory and are hence not explained. 

 

NOTE :- The Administration menu is available to only administrator  user with default password 
perf123. A guest user with password perf123 is  also shipped by default 

 

4.3 Jensor Sessions 

Data collected between a Start Session and Collate Records signal essentially forms a Jensor 
session. Stop Session signal only stops capturing the application data. Collate Records signal stops 
Jensor and transfer file to local or remote JAW as the case may be. 

 

Sessions are related to a given Jensor “project”. Jensor can detect whether or not a given session 
belongs to a given project in JAW since the project information is embedded at instrumentation time. 
Hence it is important to use right “project” to collate data from right servers. More details will be 
explained in section 5.1  

 

4.4 Accounting Information for interaction with Cor e 

Any signals from local or remote JAW are logged into a file called accounting.log in 
$JENSOR_HOME\output directory on the server where Jensor enabled application or the Jensor 
Core is running. Hence all interaction like starting a session, stopping a session or collating records 
are written to this file.  
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5 Jensor Project 

This section provides an overview of Jensor Project 

5.1 What is a Jensor Project? 

Jensor project is a context of execution. One creates a Jensor project for the following reasons 

1. To instrument java class and jars/wars/ears of interest. 

2. To store and retrieve analysis modules. 

Jensor project resides as a directory on the file system. When a project is created, Jensor creates a 
directory by the same name as the project inside JENSOR_HOME/projects directory. The newly 
created project directory contains 3 more sub-directories viz. 

�  Bin :- All analysis results are stored into and retrieved from this directory. User should 
not modify this directory or its contents. 

�  Instrumented :- Once instrumentation is carried out through Jensor UI, this directory 
contains the instrumented code. 

�  Unistrumented :- Before the selected code the instrumented, Jensor backs up original 
copy of the code. This directory will contain the original uninstrumented code. 

All three directories are initially empty. They get populated as operations are performed through 
Jensor UI.  

 

The following picture shows an example 

 

  

 

 

 

 

 

 

 

 

 

Fig. 6. Jensor Directory Structure 
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5.1.1 Creating a Jensor Project 

This section describes the steps to create a Jensor project. 

 

1. Go to JENSOR_HOME/bin and execute startup.bat or ./startup.sh as appropriate.  

2. Jensor UI will be launched. Navigate to File –> New  or press Alt + F + N 

3. Name the project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 7. Creating Jensor Project 

 

This will create a directory called Test in JENSOR_HOME/projects. The ‘Test’ directory will consist of 
3 empty sub-directories viz bin, instrumented and uninstrumented. The fully qualified path of these 
directories will be JENSOR_HOME/projects/Test/bin, JENSOR_HOME/projects/Test/instrumented 
and JENSOR_HOME/projects/Test/uninstrumented respectively. 
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6 Instrument-Deploy-Profile 

This section provides detailed information on Jensor usage methodology. It emphasizes more on 
instrumentation using Jensor. 

6.1 Instrumenting Desired Classes and Jars/Wars/Ear s 

Instrumentation is the process of writing compiled bytecode instructions into already compiled 
bytecode. Jensor does it statically by reading Java files from the files system. Jensor Instrumentation 
Engine as depicted in Fig.1 Jensor Architecture is responsible for instrumentation. After 
instrumentation, the code emits various types of information that can be useful for baselining code 
performance and detecting bottlenecks. Jensor provides two ways of instrumenting viz. GUI mode 
and Command Line mode.  

6.1.1 GUI Mode 

Jensor provides facility to instrument desired classes contained within Directories or Jars or Wars or 
Ears. To instrument classes, do the following 

1) Open desired Jensor Project. 

2) Navigate to Mode –> Instrument  

3) A Pop-up Dialog will open with two options namely, 

�  Folder 

�  War/Ear file 

Here it needs to be selected, whether you want to instrument a War/Ear file or  a set of 
classes and jars contained inside a folder. 

4) If the “Folder” option is selected, then a File Dialog box will open – Navigate to directory which 
contains classes and jars to be instrumented. Jensor can recursively traverse a directory and 
instrument all classes within. Similarly, Jensor can look within a Jar and instrument the 
classes.  
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Fig. 8. Instrumentation UI 

 

There are 3 frames in the screen above 

1. The first frame lists all Java classes contained in the directory selected in File Dialog Box in 
the earlier step. 

2. The second frame lists all sub-directories of the selected directory. You can navigate to any of 
the sub-directories to instrument desired classes. 

3. The third frame lists all the Jars in the selected directory. One can navigate inside a Jar and 
decide which classes inside the Jar need to be instrumented. 

 

After the selection process is completed, Jensor will list all classes – be them within the directory or 
within Jar – and get a confirmation before instrumentation. After confirmation Jensor will instrument all 
selected classes. Currently Jensor can instrument 800+ classes in less than a second. 

Before instrumentation Jensor will backup a copy of original uninstrumented code to “uninstrumented” 
directory within the project directory. The instrumented code will be placed in “instrumented” directory 
within the project directory. This directory will contain the same structure as that of the directory 
selected in File Dialog Box earlier, except the difference will be that “Selected” classes will be 
instrumented. 

5) If the “War/Ear file” option is selected, then a File Dialog will open. Using this file dialog, the 
user can select the War/Ear file to be instrumented. The processing would differ depending 
on whether a War file is selected or an Ear file as described below. 
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6) If a War file is selected then the instrumentation process is similar to the instrumentation of 
classes and jars within a Folder, except that the entire thing is preceded by the 
decompression of the War file into a folder structure. After decompression of the War file, a 
dialog box opens with two options as seen below. 

 

 

 

 

 

 

Fig. 9. War Instrumentation options 

 

7) If an “Ear file” is selected, then a Pop-up dialog will open for each war file contained inside the 
Ear file, with three options namely, 

 

 

 

 

 

 

 

Fig. 10. Ear File Instrumentation 

 

If the first option is selected, then all the .class files and .jar files within the particular War file 
will get instrumented. However later while collecting the logs the user can apply a filter by 
creating a file inside the %JENSOR_HOME%\config folder, named “ProfileClasses.txt”, which 
contains the names of the classes for which data needs to be collected. 

If the second option is selected, then the selection and instrumentation will take place as in 
case of instrumenting a single War file. 

After all the War files are done, the contents of the Ear file are also displayed in a 3 Frame 
format as for the Folders or the War files. 

 

NOTE:- PLEASE READ THIS SECTION THOROUGHLY 
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The instrumented code now embeds the project name. Once this instrumented code is deployed, the 
Jensor output can only be analysed by the project which was used to instrument it. Trying to Collate 
Records from any other project for this particular application will result in a mismatch of project 
names. Subsequently no analysis will be performed. Hence it is important to remember which project 
is associated with which instrumented set of code. In case of collating records from a remote JAW, a 
project by the same name needs to be created in JAW to be able to remotely pull data from Jensor. 

 

For example, lets say you created a project called “Test” and instrumented code using this project. 
When this code is deployed in your application, Jensor output will contain references to “Test” project. 
Hence you can only Collate Records for this application only from “Test” project in the JAW. In case 
you are collating from a remote JAW, you will first need to create a project named “Test” in the remote 
JAW. 

 

Current version of Jensor can monitor only one JVM on a physical system. Effect of running multiple 
Jensor instrumented applications on one physical server is unknown. Similarly, in this version of 
Jensor only one remote JAW should pull data from Jensor Core at a given time. Effects of pulling 
Jensor data from more than one JAW is unknown. Also all remote JAW actions are logged into 
Accounting.log file on the server where Jensor Core is running. 

 

6.1.2 Instrumenting Jar Files on Command Line 
Jensor provides a command line method for instrumenting Jar and class files. This is typically useful 
in environments where the Java Swing GUI cannot be accessed. The steps are as follows 
 

1. Copy all the jars you wish to instrument in %JENSOR_HOME%\instrumentation\jar 

2. Execute PopulateList.bat or PopulateList.sh file as per your platform. This should create a file 

called InstJarList.txt and enumerate all jars in this directory, one entry per line. 

3. For a fresh instrumentation session it is recommended that 

%JENSOR_HOME%\instrumentation\jar\orig folder is empty. 

4. Open a command prompt and navigate to %JENSOR_HOME%\instrumentation\jar folder. 

5. Run DisplayJarContents.bat or DisplayJarContents.sh.  

6. This utility will run through all jars mentioned in InstJarList.txt. 

7. It will create a .conf file for each jar mentioned in InstJarList.txt. 

8. The .conf file will contain entries of jar file. You can edit this file to keep entries of only those 

classes which you want to instrument. You can delete entries of classes which you do not 

want to instrument. If this file is not edited all classes will subsequently be instrumented. 

9. Jensor 1.10 provides mechanism to suppress data from unwanted classes at runtime. So 

even if you do not edit the .conf file - it is OK. See section on Jensor Control Engine. 

10. To do actual instrumentation, run JarInstrumentation.bat <projectName> or 

JarInstrumentation.sh  <projectName> . Pass it an argument corresponding to your project 

name. Remember all instrumentation needs to be bound to a project name so that it can be 

analysed through local or remote JAW. This utility will do the following things 

a) Run through all .conf files and collect information about which classes within which jars 
should be instrumented. 
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b) Back up all jars in \orig folder. If a jar already exists in \orig, Jensor cannot backup the jar. 

It will throw an exception and that jar will not be instrumented. Hence ensure that the \orig 
directory does not contain a jar(s) by the same name as the ones that are to be 
instrumented. 

 
c) Next it will instrument classes within jars as mentioned in InstJarList.txt. Instrumented 

jar(s) will be found in %JENSOR_HOME%\instrumentation\jar 
 

d) These jars are now instrumented and can be deployed in target application. 

 

6.1.3 Instrumenting Class Files on Command Line 
Jensor provides a command line method for instrumenting Jar and class files. This is typically useful 
in environments where the Java Swing GUI cannot be accessed. The steps are as follows 

 

1. Copy all the .class files or the directory structure containing your .class files that you wish to 

instrument in %JENSOR_HOME%\instrumentation\classes.  

2. Execute ClassInstrumentation.bat  <projectName> or  ClassInstrumentation.sh  

<projectName>  file as per your platform. This should run through all files and directories 

placed under %JENSOR_HOME%\instrumentation\classes and instrument all the .class files 

3. Before instrumenting, it will backup all the contents in 

%JENSOR_HOME%\instrumentation\classes\orig folder 

4. All instrumented .class files will be present in folder / files you placed under 

%JENSOR_HOME%\instrumentation\classes 

5. This instrumented content can be taken back to create a .war or .ear  files as appropriate. 

 

For a fresh instrumentation session it is recommended that the orig folder be kept empty. 

 

6.2 Deploying the Instrumented Code 

The code which is now instrumented will need to be deployed in target environment to obtain profiling 
data. Deploying Jensor instrumented code is a 2-step process. 

 

6.2.1 Pickup Instrumented Code from Jensor Project 

Suppose, a project “Test” was created, and some classes and jars were instrumented using GUI 
mode, then  

JENSOR_HOME/projects/Test/instrumented – directory will contain all the instrumented code. 

JENSOR_HOME/projects/Test/uninstrumented – directory will contain all the original un-instrumented 
code. 

Copy the instrumented code from JENSOR_HOME/projects/Test/instrumented directory and deploy it 
in target environment. If the instrumented code was an exploded .war or .ear achive, one will need to 
create a .war or .ear file from the contents under JENSOR_HOME/projects/Test/instrumented. 



Jensor 1.10 Usage Manual 

      22
  

 

Ensure that your deployment process does not includ e compilation and rebuilding of jar, war 
and ear files. 

 

6.2.2 Adding Jensor jar to application classpath 

The next step is to add Jensor classes in the classpath of target application. Jensor classes are 
contained in JENSOR_HOME/lib/jensorjdk14-v19-<platform>.jar where platform is win32 or unix. 

 

In most environments copying the jar mentioned above to WEB-INF/lib folder of your application will 
suffice. Refer your platform guide for specific instructions to add Jensor jar to your application 
classpath. 

 

Only after both steps are completed, should the tar get application be started. 

 

6.3 Profiling the Jensor Instrumented Application 

Once the Jensor-instrumented code is successfully deployed in target environment, Jensor will start 
writing 3 logs files to %JENSOR_HOME%\output directory viz. 

1. JensorProfile.txt – contains Jensor logs. 

2. memusage.csv – contains memory snapshot taken every configurable interval of time. 

3. topNMethods.csv – contains instantaneous list of bottleneck methods identified every 
configurable interval of time. 

4. ObjectInst.txt – contains Object Instantiation related details. 

 

All files are written to until a Collate Records signal is received. Upon collation Jensor transfers data 
to JAW using JCE. All files in %JENSOR_HOME%\output folder are truncated. Jensor begins 
rewriting these files when a Start Session signal is issued. 

 

Every collation corresponds to one session. All analysis modules can be analyzed on a per session 
basis. It is a good idea to collate records in periods of no or low activity in the target application. 

 

What and how Jensor captures data can be configured. Some of the parameters are configurable 
through Jensor.properties file in $JENSOR_HOME/config directory whereas some some can be done 
through Jensor Control Engine. The properties that can be configured through Jensor.properties are 
as follows 
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NUM_EXPENSIVE_METHODS=15 

Capture top <N> bottleneck methods in real-time. Default is 15. 

 
REFRESH_INTERVAL=5000 

Take memory snapshots once every <N> milliseconds. Default is 5000 milliseconds. 

 
JENSOR_PORT=21999 

Port on which Jensor TCP / IP Server listens for the commands from JAW to Start/Stop and Collate 
records.  

 
 
TCPIP_BUFFER_SIZE=8192 

Buffer size in bytes, used for the transfer of data files to remote JAW. This parameter can be tuned to 
speed up data transfers over network. 

 
 
START_AT_APPLICATION_BOOT=true 

Indicates whether to start data Collection during application startup. When set to false Jensor will not 
capture data unless explicit signals are sent through JAW to start data collection. This option is useful 
when one wants to capture Jensor data only in particular locality of the application. 

 

CAPTURE_OBJECT_INSTANTIATION  

Indicates whether Object Instantiation related data has to be captured. This option can be turned off, if 
collecting Object Instantiation data proves too expensive. 

 

FILTER_APPLIED 

Indicates whether a filter is to be applied while profiling. This alongwith FILTER_BY helps in providing 
for Method-level filtering. 

 

FILTER_BY 

Indicates which filter is to be applied. The value could be either PACKAGE or CLASS or METHOD 
depending on the filter being applied. But for this to come into picture FILTERE_APPLIED has to be 
true. 
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7 Jensor Control Engine 

This section provides in-depth information about Jensor Control Engine. 

7.1 What is the Jensor Control Engine? 

Selective profiling is a required feature. The ability to turn on and turn off profiling classes without 
needing to add or remove instrumentation is very desirable. Jensor Control Engine (JCE) provides the 
capability to capture or supress profiling data from selected classes at runtime without any need for 
instrumentation / de-instrumentation of classes. Simply put, JCE acts as a filter for classes whose 
data should be captured or supressed. 

 

Current version of Jensor requires one restart of the JVM for the filter to reflect. Future versions of 
Jensor will support on-the-fly support for modifying filters without requiring a restart of the JVM.  

 

7.1.1 Obtaining Selective Outputs 

PERC suggests two procedures for obtaining selective outputs for maximizing the benefits of JCE. 

 

Procedure 1 :- Step down 

1) Instrument  all classes in the application. 

2) Enable capturing profiling data for all methods in class files. This way initially JensorProfile.txt 
will generate enormous amount of logs. Likewise processing times for different analysis 
modules will be higher. 

3) Take Summary Report , Sort  methods by total response time. Names of slow methods will 
bubble up on the top. 

4) Take top 10 slow methods and look up their Call Traces . Note down which child methods 
take time. 

5) This way you can narrow down top 50 or top 100 slow methods. 

6) Configure JCE to monitor only the slowest 50 or 100 methods or classes to which these 
methods belong. Steps to configure JCE are given provided in section 6.1.2. 

7)  Upon next restart of the JVM, Jensor will only report data about classes filtered by the JCE. 

 

Procedure 2 :- Step up 

1) Instrument  all classes in the application. 
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2) Configure JCE only for methods/classes/packages you suspect to be the bottlenecks. Steps 
to configure JCE are provided in section 6.1.2. This way initially JensorProfile.txt will be 
smaller in size. Likewise processing times for different analysis modules will be lower. 

3) Take Summary Report , Sort  methods by total response time. Names of slow methods will 
bubble up on the top. 

4) Take top 10 slow methods and look up their Call Traces . If the Call Traces  are too short and 
do not provide adequate information look up the source code of the application and see what 
other class methods the current method calls. 

5) Expand your filter set to accommodate these additional methods/classes/packages. 

6) Upon next restart of the JVM, Jensor will only report data about newly added classes to the 
JCE filter. 

7) Repeat steps 1 – 6 until results are rich enough to locate bottlenecks. 

 

PERC recommends procedure 1 since it does not require refering to source code. Future versions of 
Jensor may provide following enchancements to make this task simpler by : 

1) Automating the whole process based on response times. Jensor knows response times of 
methods and can decide if its worth logging data about the current method. 

 

7.1.2 Configuring Jensor Control Engine 

This section outlines the procedure to configure Jensor Control Engine. 

There had been a lot of queries as to if Method-level filtering is possible. Looking at the demand 
from Jensor v1.10 onwards, a provision has been made for Method Level Filtering. This will help 
the user in having a stricter control over the data collection process. For this two additional 
properties have been added to the file named “Jensor.properties” namely, FILTER_APPLIED and 
FILTER_BY. The value of the property FILTER_APPLIED needs to be “TRUE” if the filter is to be 
applied, “FALSE” otherwise. If the property FILTER_APPLIED is true, the value of the property 
FILTER_BY will determine as to which filter is to be applied. The value for FILTER_BY could be 
either “PACKAGE” or “CLASS” or “METHOD”. 

From Jensor v1.10 onwards, there are three files generated with every instrumentation process 
performed by the user namely, ProfilePackages.txt, ProfileClasses.txt, and ProfileMethods.txt, 
these files will be created inside the “projects\<User_Project_Name>\bin” folder . 

Based on what values the user sets for the property FILTER_BY, s/he will need to place the 
relevant file in the folder “config” under the JENSOR_HOME directory. So if the user selects 
“PACKAGE” as the value for the property FILTER_BY, the file that needs to be placed in the 
config folder will be ProfilePackages.txt. However the user needs to take care that the entries 
related to only those packages/classes/methods, as the case may be, for which s/he needs to 
collect data, are present in the file. 
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So the steps for configuring the Jensor Control Engine are as follows 

1. At each instrumentation process, the three files namely, ProfilePackages.txt, 
ProfileClasses.txt and ProfileMethods.txt are created in the 
$JENSOR_HOME/projects/<USER_PROJECT>/bin  directory. 

2. For applying filter the user needs to change the “Jensor.properties” file, where two entries 
need to be modified namely, FILTER_APPLIED  and FILTER_BY. 

a. FILTER_APPLIED  needs to be set to TRUE if filter has to be applied, FALSE 
otherwise. 

b. FILTER_BY needs to be set to either PACKAGE or CLASS or METHOD , depending 
on which filter the user wants to apply. 

3. The next step is to copy one file from the 
$JENSOR_HOME/projects/<USER_PROJECT>/bin  directory to the 
$JENSOR_HOME/config  directory. The file to be copied will depend on what value has been 
set for FILTER_BY property. 

a. If FILTER_BY=PACKAGE, the ProfilePackages.txt file needs to be copied 

b. If FILTER_BY=CLASS, the ProfileClasses.txt file needs to be copied 

c. If FILTER_BY=METHOD, the ProfileMethods.txt file needs to be copied 

After copying the file, edit it such that it contains entries of only those 
packages/classes/methods for which data needs to be collected. 

 

If later on the user decides to remove the filter, s/he needs to change only one entry in the 
“Jensor.properties ” file in the $JENSOR_HOME/config  directory, and set 
FILTER_APPLIED=FALSE . 
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8 Jensor Analysis Workbench 

Jensor Analysis Workbench provides 11 different tools/ modules for analyzing Jensor output. Some 
modules (like Pattern Analysis ) aggregate performance data while some (like Debug Tree ) perform 
drill-down. Using multiple modules in conjunction helps in sharpening the analysis. JAW aims at 
accelarating time taken to locate and eliminate bottlenecks in a given code by providing various ways 
of looking at the same data. 

JAW also includes Tagging Engine which helps in extracting business information based on technical 
output produced by Jensor. 

 

8.1 Using JAW 

8.1.1 Launching the Analysis Module 

Launch Jensor UI using startup script in JENSOR_HOME/bin. Open a Jensor project and navigate to 
Mode -> Analyze. Jensor presents 11 different modules to analyze output collected by Jensor. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 11. Launching JAW 
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9 Reports 

Jensor provides the following types of reports.  

1. Summary Report  – A per thread per method statistics sheet. 

2. Call Trace / Debug Tree – Reproduces order of execution of methods in a given thread. 

3. JVM Replay  – Animated replay of all instrumented methods across all threads. 

4. Pattern Analysis  – An aggregation tool to identify bottleneck call patterns. A pattern is a set 
of method calls. Optimizing a pattern has cascading effects on JVM performance. 

5. Charts  – This module pictorially depicts bottleneck methods at any instant of time correlated 
with Java Heap memory consumption. 

6. Unexited  – Provides a list of methods which do not exit normally. 

7. Unexited Details  – Provides a call trace of methods which do not exit normally. 

8. Tagging  – Allows creation of tags. Tags can be used for technical as well as business 
analysis. For e.g. Technical tags could be {JSP, EJB, JDBC, MDB} and Business Tags could 
be {Deposit, Withdrawal, Enquiry} etc. 

9. Simple Tagging (Pie-chart ) – Response times broken up as per a given set of tags. For e.g. 
response times could be broken up into time spent in JSP, EJB, JDBC, MDB etc.  

10. Advance Tagging (Nested Pie-chart ) – Allows nesting of tags, so one can answer questions 
like how much of response time of say Withdrawal transaction is spent in JDBC or say which 
transaction spends most time in JSP? 

11. Response Time Spectrum  – A spectrum-like representation of method response time v/s 
time of the day. A response time spectrum provides more accurate picture of response time 
behavior since the data is not normalized using averages. 

12. System Metrics – Provides the user with a view into the details of the System in terms of the 
Processor, Memory, Network and Disk metrics. 

 

Detailed description is provided in next sections. All the reports below are invoked after launching 
Jensor UI and opening a project. Only after opening a project, the Mode menu in Jensor UI gets 
activated. Navigate to Mode -> Analyze  to invoke the desired report.
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9.1 Viewing the Summary Report 

Summary Report  module of Jensor can be invoked through Mode -> Analyze -> Summary 
Reports . A Summary Report  provides per thread per method statistics as follows 

�  Number of invocations of a particular method in a particular thread. 

�  Total time spent across all calls to that method in that thread in milliseconds. 

�  Average, Maximum and Minimum response time in milliseconds.   

An example is provided  below. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 12. Summary Report 

 

The first red rectangle above shows that there were 3810 invocations of AnyHandler.startChild() in 
thread p:thread-pool-1;w: 28. All 3810 invocations completed in 4537 milliseconds with avg, max and 
min response times for this function in this thread equal to 1, 1418 and 0 milliseconds respectively. 

 

Similarly, the second red rectangle depicts that the same function in a different thread viz. p:thread-
pool-1;w: 4 spent 6178 milliseconds accross 9398 invocations with average rounded off to 0 
milliseconds. The max and min response times were 783 and 0 milliseconds respectively. 



Jensor 1.10 Usage Manual 

      30
  

 

The order of the Summary Report  table can be sorted. Also the data in the table can be copied to a 
spreadsheet software like Microsoft Excel using Ctrl + A and Ctrl + C and Ctrl + V keystrokes.
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9.2 Viewing the Call Trace Report 

Debug Trace provides a call trace of the application i.e. it provides a “who called who” graph. 
Response time break-up can be obtained using this report. A Debug Trace can be invoked navigating 
Mode -> Analyze -> Debug Tree  menu. There are 4 panels on this screen. Each of them is labelled 
appropriately in the diagram and explained below.  

 

 
 

Fig. 13. Debug Tree / Call Trace 

 

Call Tree Panel:- Depicts entire call trace for all threads. Time consuming method calls are painted in 
red and more frequently called methods are painted in blue. From Jensor v1.7 onwards, a search 
facility has been provided. 

Sometimes it is desirable to search within the call trees for manually tracking certain methods. The 
Call Trace, Pattern Analysis, Unexited and Unexited –Details module present data in form of call 
trees. This version of Jensor provides facility to search for and navigate to desired methods in these 
trees. The procedure to do so is as follows 

 

 

Call Tree Panel 

Method Detail Panel 

Thread Panel 
TopNMethod Panel 
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Operational Details for Searching Call Trees 

For searching the Call Tree, the user needs to focus on the Call Tree and then type the fully qualified 
Node name s/he wants to search for. With every change in the string, the search is refreshed and the 
the appropriate node will be highlighted. If there are more than one nodes satisfying the criteria, then 
the user can scroll through the nodes by using the up and down arrow keys. To come out of the 
Search mode, the user must press the ‘Esc’ Key on the keyboard. 

Extended Operational Details for Searching Call Tre es 

The search feature can be controlled by setting the value of the property “TREE_SEARCH” in the file 
DebugTrace.properties, which exists in $JENSOR_HOME\projects\<project_name>\bin folder. The 
following settings are available: 

�  “ON” – By setting the TREE_SEARCH value to ON the user can forcibly enable the search 
feature. 

�  “OFF” – By setting the TREE_SEARCH value to OFF the user can forcibly disable the search 
feature. 

�   “AUTO” – By default, the value of the variable is AUTO. In this case, if the number of nodes 
are more than 50000 then the search feature is automatically turned OFF else the search 
feature is turned ON. 

Thread Panel:- Provides thread list to quickly locate and analyze events in a given thread. 

Method Detail Panel: - Provides details about the last selected method calls. The panel holds a table 
with 8 columns, viz. 

�  Function Name :- Name of the method 

�  Tags :- If a method is tagged, this column depicts those tags, else it is blank. 

�  Entry time :- This column is currently masked out in this version. Future versions on 
Jensor will populate this column with method entry time. 

�  Call Count :- This version of Jensor will always report it as 1 (one). When Jensor 
supports folding information like say detecting loops or recursion, this column will 
actually depict time taken for a loop or a recursive call to finish. 

�  Total / Avg / Max / Min Response times (in milliseconds) – Since call count is 1 (one), 
all 4 columns report the same value. 

To clear the rows in panel 3, use CLEAR TABLE  button. By default Jensor UI show 31 last 
selected me methods. To change this setting, go to Mode -> Change Properties  and change 
the number of last selected method calls. All time consuming methods in this table are 
highlighted in red colour. 

TopNMethod Panel:- This panel has many sub-panels. One corresponding to each thread plus one 
for aggregating information across all threads. By default the ALL tab is open. It provides information 
about bottleneck methods and the thread it is located in. The other tabs are named same as the 
thread names and provide response time information about bottleneck methods in this thread. By 
default
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9.3 Using JVM Replay 

JVM Replay is useful in replaying the call method call sequence. It can be invoked by navigating 
Mode -> Analyze -> JVM Replay  menu. The JVM Replay  module animates the call sequence across 
all threads. This helps in investigating scalability as well as reliability problems. 

 
Fig. 14. JVM Replay 

 

Use the Play, Pause and Stop  buttons to control the animation. You can slow down the animation by 
adding delay. The table represents a call trace. The table has 7 columns viz. 

1. Function Name :- Name of the function 

2. Entry Time :- Relative time in milliseconds since invocation of the first Jensor-enabled method 
in the JVM. The red rectangle on top is start time in milliseconds since epoch i.e 1st January 
1970, 0:00:00, GMT 

3. Call Count :- Number of invocation of this method. 

4. Total / Avg / Max / Min response time in milliseconds. 
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9.4 Analysing Method Call Patterns 

Jensor is capable of detecting patterns in Java code. A pattern is a set of method calls. For e.g. if 
method A calls method B which calls method C, then Jensor reports 3 patterns viz. 

Pattern 1 : A() 

Pattern 2 : A() – B() 

Pattern 3 : A() – B() – C() 

Pattern Analysis  module can be invoked using Mode -> Analyze -> Pattern Analysis  menus. 
Future versions of Jensor will be able to identify that all three patterns are in fact a part of the same 
call sequence. Pattern Analysis  is a powerful tool, since it aggregates the data as well as provides 
granular information about each method call. Optimizing a method call can provide local benefits, but 
optimizing a pattern can have cascading effects on application and JVM performance. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 15. Pattern Analysis 
 

Pattern Panel depicts all patterns. TopNMethod Panel shows 2 tabs – one in red and one in blue. The 
red one denotes patterns with high response times and blue one denotes patterns with high call 
count. In the figure above, the first row in table in TopNMethod panel depicts that pattern with top 
level function CSFConsumerBase.ejbCreate() was called 57 times and it took 15 milliseconds to 
execute it. 

Pattern Panel 

TopNMethod Panel 

Pattern Detail Panel 



Jensor 1.10 Usage Manual 

      35
  

This version also provides a feature for searching the Patterns Tree. For more details regarding the 
Search feature refer the “Operational Details for Searching Trees” under the Section 9.2. 

Pattern Detail Panel depicts a table with 4 columns, viz 

Level in the pattern : - Jensor terms methods called by run-time environments as Level 0 (zero) 
methods. This column depicts the pattern depth. 

Function Name :- Name of the function at a given depth. 

Response Time :- Time taken to complete all invocations of this method in milliseconds. 

Call Count :- Number of invocations. (see example below for correct interpretation of this term). 

 

In example depicted above, 61 calls to the pattern completed in 2 milliseconds. It is important to 
note that the pattern repeats 61 times. It does not  necessarily mean that every function at 
every level of depth repeats 61 times. It could als o be that methods at level 0-3 execute only 
once, but method at level 4 executes in a loop 61 t imes. Future versions of Jensor will improve 
upon this feature. 

 

The number of patterns that JAW can detect is dependent on the depth of call tree that JAW is 
configured to look at. The deeper JAW can look into the call tree, the more patterns it can generate. 
By default JAW can look 4 levels deep. For e.g. if a call trace looks like A() –> B() –>C() –>D() –> E() 
then by default JAW will be able to see only upto D(). To instruct JAW to look deeper, one needs to 
change JAW properties by invoking Mode -> Change Properties menu. 
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Fig. 16. Change JAW Properties 

 

After configuring the desired pattern depth, one needs to regenerate patterns by invoking Mode -> 
Pattern Analysis  menu.
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9.5 Viewing Method Histogram and Memory Usage Chart s 

The Charts  module depicts two charts namely 1) Method Response Time Histograms and 2) Memory 
Usage charts. The Charts  take memusage.csv and topNMethods.csv as inputs. These files are 
output by Jensor and can be found in JENSOR_HOME\output directory. The Charts  module is 
invoked by navigating to Mode -> Analyze -> Charts   

 
 

Fig. 17. Method Histograms and Memory Charts 

 

The bar charts in upper frame depicts method response time histograms. The frame depicts the top N 
bottleneck methods at a given instant of time. For example, the chart above depicts that at 16:25:29 
487, CSFListenerRegisteringConsumer.onRequest() is the method which has maximum execution 
time in the JVM.  Across 2 (two) calls, this method has spent 375 milliseconds under execution. The 
format of the method histogram is function name : frequency on one axis and cumulative response 
time in milliseconds on the other axis. 
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The line charts in the lower frame depict memory consumption. X-axis of this chart is time of the day 
and Y-axis is memory usage measured in MB. Both Charts, histogram and memory usage charts are 
synchronized on time. When the Play button is depressed, the animation begins. In the top frame it 
depicts the bottleneck response time at a particulat instant in time. In the lower frame the cross-bar 
moves depicting the exact memory usage at the same point in time. Thus a strong correlation 
between memory comsumption and running methods is established. Users can use this data for 
further analysis. To get detailed memory usage click on Memory Usage for Full Duration. A small 
window pops up. Graph in this window can be zoomed in and out to perform detailed analysis. 

 
 

Fig. 18. Memory for Full Duration 

 

Area is selected using the dragging operation of mouse. 

 
Fig. 19. Zooming-in Memory for Full Duration 

 

The selected area is then zoomed into, showing details of that time duration. Note that time between 
16:25 and 16:31 is selected. 
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Fig. 20. Memory for required duration 

 

Events in time period 16:25 to 16:31 are magnified.
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9.6 Viewing Unexited Methods 

Methods which don’t exit are of special interest. They provide an interesting insight into reliability of 
application under test. There are two modules related to unexited methods viz Unexited  and 
Unexited – Details . They can be invoked through Mode -> Analyze -> Unexited  menu. 

 
Fig. 21. Unexited Methods 

 

The left hand side frame depicts threads which have unexited methods. The right hand side frame 
depicts methods in that thread which have not exited. A method can be unexited under the following 
circumstances 

1. If a method stalls for a long time and does not return to its caller. 

2. A method throws an exception and exits via an alternate path to the runtime. 

3. A method is designed never to exit (similar to a daemon thread). 

Knowing which methods have not exited can thus provide a pointer towards application functionality,  
performance, scalability and reliability. This section provides details only about methods which have 
not exited. This module depends on how deep JAW is allowed to see. By default it can see methods 
as deep as the Debug Trace / Call Tree  module can see.If the depth of a call tree is altered it will 
reflect in this module after regenerating the results. Jensor marks an unexited method by assigning it 
a response time of -1 (minus one). 
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Unexited – Details  module differs from this module in a very small way. Unexited – Details  presents 
entire call trace where as Unexited  module only provides details on those calls that have not exited. 

The figure below depicts Unexited – Details . 

 
Fig. 22. Unexited methods -Details 

 

The columns of the table in right hand side frame are explained below.  

�  Sr. No :- Serial number, just an identifier to identify how many calls are made in this call trace. 

�  Level :- Depth at which this method is executed. 

�  Function Name :- Function name 

�  Entry Time :- This information is suppressed in this version of Jensor. Future versions will 
release it. 

�  Call count :- Number of invocations of a method at a particular level. In this version of Jensor 
it will be uniformly 1. 

�  Total / Avg / Max / Min response time :- Response time in milliseconds. Unexited methods 
have a response time of -1 (minus one) and are marked in grey. 

This version also provides a feature for searching the Call Trees in case of Unexited and Unexited - 
Details. For more details regarding the Search feature refer the “Operational Details for Searching 
Trees” under the Section 8.2. 
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9.7 Tagging Engine 

This section describes 3 modules – Tagging , Pie-Chart  and Nested Pie-Chart . Tagging  can be 
invoked by navigating to Mode -> Tagging  menu. Tagging  allows a Jensor user to classify method 
into various categories by use of tags. For example, a method may be a JDBC method, belonging to 
application App1 and written by Vendor V1. Jensor allows you to attach multiple tags to a method and 
see a breakup of response times as per those tags.  

To use tagging engine, the following procedure needs to be followed. 

1. First, create tags using Mode -> Tagging -> Create Tags  feature. So say a set of J2EE 
components or names of vendors etc can be created as tags. 

 

 
 

Fig. 23. Tagging Menu 
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2. A Tag is an identifier. One can create tags for representing technical as well as business 
perspectives. For e.g. the figure below creates tags to break down function calls into its Java 
Components like EJB, JDBC, Servlet, JMS, MDB etc. 

 

 
Fig. 24. Tag Creation 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



Jensor 1.10 Usage Manual 

      44
  

3. Save the tags by a name. For e.g. all the java components like JDBC, SERVLET, JMS are 
saved as, say JAVA_COMPONENTS ’tag file. 

 

 
Fig. 25. Tag Naming 

 

4. Next step is to Perform Tagging  by invoking Mode -> Tagging -> Perform Tagging  menu. 

5. Here you will be presented with a list of methods captured by Jensor. At one time, you can 
apply only one set of tags i.e. when performing tagging using JAVA_COMPONENTS you can 
tag a particular function as belonging to a particular Java component. Similarly, user can 
create a OperationsTag using tagging feature, which can include operations like UPDATE, 
INSERT, DELETE, CREATE etc. The next figure shows how to perform tagging using Jensor 
UI. 
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Fig. 26. Perform Tagging   

 

There are no limitations on the number of tags created. For each such tag created, one needs to 
do Perform Tagging for a tag to be useful during analysis. 

 

6. When creating Pie-Charts , the drop-down menu will automatically be populated with as many 
tags that have been created for that project. You can also import tags from other project using 
Import / Export Tags functionality. 

7. Nested Pie-Charts  are also created in a similar way. Currently nesting is supported upto 4 
levels deep i.e. one can nest upto 4 tags in this version of Jensor. 

 

Using simple tagging, one can answer questions like 

�  How much time is spent in different J2EE components like say JSP, Servlet, EJB, JDBC etc? 

�  What is the performance of vendor delivered code? 

�  In which functionality of the application has the highest / lowest response times? 
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Fig. 27. Simple Tagging : Component-wise breakdown 

 

The diagram above depicts that 38% of the time is spent in doing JDBC calls. 



Jensor 1.10 Usage Manual 

      47
  

 

 
Fig. 28. Simple Tagging : Vendor-wise breakdown 

 

The figure above depicts that almost 81% of the time is spent in code written by Vendor2. 

 
Fig. 29. Simple Tagging : Functionality-wise breakdown 



Jensor 1.10 Usage Manual 

      48
  

The figure above depicts that 48% of response times are attributed to CSA functionality of the 
application. 

Jensor also, provides advanced functionality. In this functionality, one can do nesting of pie-charts. So 
the following questions can be answered using Nested Pie-Charts .  

Lets say, we create tags for identifying J2EE components like EJB, JMS, JDBC, MDB, Servlet. Using 
Pie-charts  as demonstrated above we wish to find where is the time spent in JDBC. So say we create 
another set of tags, say, Create, Delete, Insert, Update. Now the following questions can be 
answered. 

1. How much time out of JDBC operations is spent in Create, Delete, Insert, Update operations? 

2. How many J2EE components are doing Update operations? 

3. What operations is an MDB doing? 

 
Fig. 30. Advanced Tagging : Nesting tags 

 

The 1st panel shows, response times broken up by J2EE components. It shows a total of 4763 
seconds of response time spent across various tiers. JDBC takes almost 38%. 2nd panel shows JDBC 
broken down into its operations. It depicts that the JDBC tier does Updates and Inserts. 3rd panel 
reverses the perspective and shows which all J2EE components do an Update. 4th panel shows what 
MDB was doing, namely only updates.  

 

1 2 

3 4 
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Nested-Pie Chart  or Advanced Tagging is a powerful tool which provides various different 
perspectives of looking at the same data. Tags can basically combine technical as well business 
perspective, hence this is a useful tool for business users as well. The next paragraph explains the 
procedure to use Tagging Engine. 

Import / Export Tags 

Performing tagging can be a tedious task since there can be thousands of functions. Hence Jensor 
supports import and export of tags. When exporting tags, the tags themselves along with functions to 
which these tags get applied are exporting. When importing tags one must ensure that the current 
project contains more or less the same methods as the Jensor project from which the tags are being 
imported. Jensor also supports exporting to and importing from file system. 

Breakup of Time spent by Package, Class and Method 

For getting the Breakup of Time spent by Package, Class and Method, the tags are created at the 
time of instrumentation itself. So the “package.taginit”, “package.tag”, “class.taginit”, “class.tag”, 
“method.taginit” and “method.tag” files are created. This helps the users in the sense that they need 
not go through the process of creating the tags manually. So the user will have the tags created by 
packages, classes and methods. Thus these tags will be available to the user by default. The user 
can use these especially to identify the package/class/method responsible for the highest response 
times. 

Especially with the Nested Tagging feature this will help the user as s/he can get the detailed 
understanding as to which Package is accounting for the highest response times.  Then going at a 
more granular level s/he can identify the class within that package which is taking the maximum 
response time. Again the user can go to one further level of granularity as to which method within that 
class is accounting for the highest response time. Thus the tags should be helpful in identifying as to 
where the time is being spent. 

Following figure shows the breakup of timings in Tagging Module. The first figure shows the breakup 
using the Simple Tagging(Pie-chart) module under Tagging. The second figure shows more detailed 
granular breakup of times using Advanced Tagging(Nested Pie-chart). 
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Fig. 31. Break up by Package, Class and Method (Tagging) 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 32. Break up by Package, Class and Method (Nested Tagging) 
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9.8 Response Time Spectrum 

When all instances of response times of methods are plotted against time it actually resembles like a 
spectrum. Hence this module is called Response Time Spectrum . It can be invoked by navigating to 
Mode -> Analyze -> Response Time Spectrum . A response time spectrum provides an accurate 
picture on when and where response times degrade and to what extent. Methods can be chosen from 
packages and classes through the UI. The following diagram depicts a response time spectrum. The 
diagram can be zoomed in and zoomed out like in Charts  module, to analyze events of interest in 
detail. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Fig. 33. Response Time Spectrum 
This picture depicts that response times for DatabaseService.getConnection() method degrades 
rapidly by about 30-times. Correlating this data with workload information will help in detailed analysis 
regarding scalability of the given method. 

 

From Jensor1.7 onwards, the display for the Response Time Spectrum has undergone a change. As 
displayed in the fig 31 above, a SplitPane has been used wherein the chart is getting displayed on the 
upperside of the SplitPane and the legend for the chart is getting displayed on the lowerside. Another  
change is that the legend has been converted to a table, with first column in the table representing the 
color and the second representing the Function name. 
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9.9 Object Instantiations 

The “Object Instantiations” module helps the user in getting the details regarding the objects that get 
instantiated during the selected period. The period can be selected through the dialog box that 
appears wherein the user can select the day, the hour, the minutes and the seconds for the start time 
and the end time. Based on the period selected, you get to see the information related to the Object 
Instantiation on a table on the lower side. On the upper side the user can see the Memory usage 
related chart which will help the user to decide the time period for which s/he needs to view the Object 
Instantiations data. 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

Fig. 34. Object Instantiations 
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All this can be done only if the data for Object Instantiations was collected for a particular session, 
else it will display a message as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 35. Data Unavailable for Object Instantiations 
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9.10  System Metrics 

System Metrics module of Jensor can be invoked through Mode -> Analyze -> System Metrics . 
System Metrics help the user in getting the detailed view of the System through metrics related 
to each of the following 

�  Processor 

�  Memory 

�  Disk 

�  Network or System Calls 

A sample display for the System Metrics tab for the Windows Platform is as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig 36. System Metrics display 

 

Jensor now captures System Metrics as well. In the current version, the Module is available 
for all Platforms. 
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The Windows metrics are collected from perfmon, for detailed understanding refer to the 
Object/Instance/Metric in the perfmon interface. For Unix platforms, the fourth quadrant varies 
depending on the OS and in case of non-Linux Unix Platforms, the fouth quadrant displays 
System call details instead of the usual Network details. The details related to the switches used 
in the sar command and the metrics captured are mentioned in the table below, for detailed 
understanding refer to the man page for sar. 
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Table 4. Sar Switches and Monitored metrics 

 

The System Metrics module should work fine on any Unix Platform however it has been 
tested on machines with the following OS and JVM combinations – 

·  RHEL 4 and 32-bit JVM 

·  IBM AIX 5.3 and 64-bit JVM 

·  Sun Solaris 10 and 64-bit JVM 
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Appendix 

1 Calibrations 

Jensor is very light-weight and low-overhead. Jensor has about 10 – 30 microsecond overhead per 
method. Memory requirement is proportional to number of methods in Jensor instrumented classes. 
For about 10000 methods the memory requirement is in the range of 5 MB. 

 

JAW on the other hand processes Jensor data offline. The following table depicts the  memory 
requirements for various analysis tools. The memory requirement is proportional to the number of 
method invocations during run with Jensor instrumented code. It is also roughly proportional to the 
cumulative size of .plot files generated in JENSOR_HOME\projects\<project name>\bin folder.  

 

All memory units are in MBs 

Summ
ary 
Report 

Debug 
Tree / 
Call 
Trace 

JVM 
Replay 

Pattern 
Analysis Charts 

unexited 
+ 
Unexited 
Details 

Creat 
Tags 

Perform 
Taggin
g 

Apply 
Tags 

Pie-
Chart 

Nested 
Pie-
Chart 

Response 
Time 
Spectrum 

Total 
Memo
ry 
Requi
red 

 Size 
of 
Plot 
files 

4 5 4 4 7 4 4 4 4 4 5 9 58 0.08 
3 5 4 4 7 4 4 4 5 6 5 8 59 0.1 
5 141 16 5 9 31 3 4 4 6 6 84 314 29 
6 149 5 6 10 5 4 4 4 4 5 72 274 41 
5 55 5 55 12 5 4 4 4 5 6 302 462 158 

Table 5.  JAW Memory Details 

The highlights of the table are as follows 

�  Call Trace, Pattern Analysis, Unexited methods  and Response Time spectrum  are 
memory intensive modules. 

�  Summary Report, Charts  and Tagging  Engine are light-weight wrt to memory requirements 
and do not vary much with .plot file sizes. 

�  512 MB memory should support all modules as long as total size of .plot files remain under 
200 MB. 

 

The calibration is done on desktop machine running Windows XP with Intel Xeon 2.8 GHz and RAM 
512 MB. The JDK version was Sun JDK 1.4.2_09. 

 

2 Resources 

Refer http://jensor.sourceforge.net and http://www.tcsinnovations.com for additional resources. 
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3 Jensor Roadmap  

PERC, TCS invites you to request features you would like to see in Jensor. Features may be 
prioritized based on overall demand. 

 

Next versions of Jensor will inlcude the following 

�  Improved Pattern Analysis – Elimination of redundant patterns. 

�  Support for JDK 1.5 – JDK 1.5 provides support for instrumentation using 
java.lang.Instrument package. This will eliminate the need for manual instrumentation.  

 

 

 


